
   

Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 
Semester:  B. Tech -1st Branch: Common to all Branches 
Subject: Engineering Mathematics I Code: 3000A02AT014 
Maximum/ Minimum- Passing Marks: 
Maximum: 100 
Minimum: 35 

Periods/Week: 
L               T               P                       Ass. Hours 
3               1                 0                            1/Week 

Class Tests: 2 (Mandatory) Assignments: 2 (Minimum) 
Duration (ESE): 3 hours Total Credits: 4 

 
Course Objectives 
The objective of the course is aimed to; 
1) Develop the basic mathematical skills of engineering students that are imperative for effective 
understanding of engineering subjects.  
2) Also, the topics introduced will serve as basic tools for specialized studies in many fields of 
engineering and technology. 
3) This course includes: Matrices, Differential Calculus, Partial Differentiation, Integral Calculus and 
Ordinary Differential Equations. 
Course Outcomes 
On successful completion of the course, the students will be able to: 
CO1:-​ Apply the concept of Rank of Matrices and Cayley-Hamilton Theorem. Problems on solution of a 

system of linear equations by matrix method. Implement the concept of Eigen values and Eigen 
vectors in engineering problems. 

CO2:-​ Apply the method of Successive Differentiation for Expansion of functions and Tracing of simple 
curves. 

CO3:-​ Solve the problems of Maxima& Minima of functions of two variables and use 
Jacobians in formulation of practical problems. 

CO4:-​ Apply integration for Rectification, Quadrature and Volume of revolution and apply 
Differentiation under the integral sign to definite integrals. 

CO5:-​ Solve Linear as well as Nonlinear Differential Equations of first order. Also, to solve Linear 
Differential Equations of Higher Order. 

 
UNIT– I: Matrices 
Rank of matrix by elementary transformation (Echelon and Normal form); Inverse of the matrix by 
Gauss-Jordan’s method; Consistency of a system of linear equations (Homogeneous and 
Non-homogeneous); Eigen values and Eigen vectors; Cayley- Hamilton theorem with applications.                               
[12Hrs] 
 
UNIT–II: Differential Calculus 
Successive differentiation; Leibnitz theorem; Fundamental theorems: Rolle’s theorem, Lagrange’s 
mean value theorem, Cauchy’s mean value theorem (without proof); Expansion of functions in 
Taylor’s and Maclaurin’s series; Tracing of simple curves.                               
[12Hrs] 

 
 

 



   
UNIT–III: Partial Differentiation                                                                                                   
Partial derivatives; Euler’s theorem on Homogeneous functions; Jacobians; Maxima and Minima of 
function of two variables; Method of Lagrange’s undetermined multipliers.                                   [12Hrs] 
UNIT–IV: Integral Calculus                                                                                                                                   
Reduction formulae; Application of integrals to rectification Quadrature Volume of revolution; 
Differentiation under integral sign.  ​ ​ ​ ​ ​ ​ ​            [12Hrs] 
 
UNIT–V: Ordinary Differential Equation 
Exact differential equations; Reducible to exact form; Nonlinear first order differential equation (solvable 
for p, x and y); Linear differential equation of higher order with constant coefficients; Method of variation 
of parameters; Cauchy’s and Legendre’s differential equations.                                                       [12Hrs] 
 
TextBooks:  
 

S.No. Title Authors Edition Publisher 
1) Higher Engineering 

Mathematics 
B.S. Grewal   44thEdition,2017 KhannaPublishers 

2) Advanced Engineering 
Mathematics 

H.K. Dass 28thEdition, 2012 S.  Chand 
Publication 

3) Advanced Engineering 
Mathematics 

Erwin Kreyszig 9thEdition, 2006 John Wiley & Sons 

4) Applied Engineering 
Mathematics 

MadanMohanSingh 2ndEdition,2016 B S Publications 

5) Engineering 
Mathematics (Hindi)  

S. C. Goyal 6thEdition, 2022  Khanna Publishers 

6) Engineering 
Ganit(Vol 1 aur 2) 

R. K. Jain 10thEdition, 2023  Vikas Publishing 
House 

Reference Books: 

E- resources/ Web Sources: NPTEL You Tube Channel 

●​ SWAYAM Portal: Online Lectures on Engineering Mathematics. (https://onlinecourses 
swayam2.ac.in/cec20_ma02/preview) 

 

S. 
No. 

Title Authors Edition Publisher 

1) Calculus and Analytic 
geometry 

G.B. 
Thomas and 
R.L. Finney 

9th Edition2002 Pearson, Reprint 

2) Engineering Mathematics 
for first year 

T. Veerarajan 2008 Tata Mc Graw -Hill, 
New Delhi 

3) Higher Engineering Mathematics B.V.Raman 11th Reprint 2010 Tata Mc Graw Hill 
New Delhi 

4) A text book of Engineering 
Mathematics 

N.P. Bali 
and Manish 
Goyal 

Reprint, 
2010. 

Laxmi 
Publications 

5) Ganit aur Uske Anuprayog V. K. Singh 5thEdition, 
2021 

Arihant 
Publication 

https://onlinecourses
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Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 
 

Semester-1st/2nd Branch:Circuit Branch 
Subject:Engineering Physics - A Code: 3000A03AT015 

Maximum/Minimum- 
Passing marks:100/35 

Periods/week: 
L T P Ass. Hours 
3 -- -- 1/week 

 
Class Tests: 2 (Mandatory) Assignments: 2 (Minimum) 
Duration (ESE): 3 hours TotalCredits: 3 

 
Course Objectives: 
1.​ Understand the basic principles of band theory of solids and semiconductors. 
2.​ Understand the underlying mechanism involved in construction and working principle of p-n junction diode. 
3.​ Study of principles of interference & diffraction with applications. 
4.​ Study the principle and types of lasers and optical fibres. 
5.​ Study the fundamental concepts related to dielectrics and electron trajectories in uniform electric and 

magnetic fields. 
 

UNIT I:SEMICONDUCTORS​ ​ ​ ​ ​ ​ ​ ​ [09 Hrs] 
Classification of solids on the basis of conductivity, Formation of Energy bands in solids and their diagrams 
(Energy level approach), Types of electronic materials: Conductors, Semiconductors, and Insulators on the basis 
of energy band theory, Concept of Fermi Level, Intrinsic semiconductor, Carrier concentration, Doped or extrinsic 
semiconductor: n and p-type semiconductors, Fermi level in Intrinsic and Extrinsic semiconductors, Dependence 
of Fermi level on impurity concentration and temperature, Law of mass action, Charge neutrality condition, 
Carrier transport: Drift, Diffusion and Total current. 
 
UNITII:SEMICONDUCTOR DIODE​ ​ [09Hrs] 
p-n Junction diode, Formation of p-n Junction, Depletion region, Potential barrier and its calculation, Energyband 
structure of p-n junction diode at equilibrium, Forward and Reverse biasing with energy band diagram, 
Voltage-Ampere Characteristic of p-n junction diode. Light Emitting Diode, Solar cell, Photo diode and 
characteristics. 
​  
UNITIII:WAVE OPTICS​ ​ [09Hrs] 
Superposition of waves, Interference of light by division of wave front: Fresnel’s bi-prism and its application 
(thickness of thin transparent sheet), Interference of light by division of amplitude: Wedge shaped film, Newton’s 
rings and its applications (wavelength and refractive index), Fraunhofer diffraction from a single slit, Diffraction 
grating, Rayleigh’s criterion for the limit of resolution, Resolving power of grating.  
​  
UNIT IV: LASERS AND FIBRE OPTICS​ ​ [09 Hrs] 
Einstein’s theory of matter-radiation interaction and A and B coefficients, Amplification of light by population 
inversion in optical resonator, Different types of lasers: Solid-state laser (Nd:YAG laser), Gas laser (CO2 laser), 
Semiconductor Laser. Properties of laser beam & its applications. 
Fibre Optics: Introduction, Total internal reflection, Propagation of light through optical fibre, Acceptance angle 
and acceptance cone, Numerical aperture, Types of optical fibre on the basis of Modes of propagation & Index 
profile, V-number, Fibre Losses (attenuation) and Dispersion, Advantages & Applications. ​  
​  



UNITV: DILECTRICS AND ELECTRON BALLISTICS​ ​ [09 Hrs] 
Dielectrics: Dielectric constant, Dielectric Polarization, Bound and free charges, Relation withpolarization, 
Gauss's law in dielectrics, Dielectric susceptibility, Displacement vector D, E, andP vectors, Polar and nonpolar 
dielectrics, Different types of polarization, Temperature andfrequency dependence of total polarization. 
Electron ballistics: Motion of charged particles in transverse electric and magnetic field, Aston and Bainbridge 
mass spectrograph.​  
 
CourseOutcomes: 
On successful completion of the course, the student will be able to: 
1.​ Analyze the concept of band theory and visualize semiconductor using band theory. 
2.​ Identify the role of p-n junction diode in science and engineering applications. 
3.​ Explain wave optics concept and apply it tosolve related problems in science and engineering. 
4.​ Analyze various aspects of Lasers and optical fibres and their applications in diverse fields. 
5.​ Learn to apply the concepts of dielectric and electron ballistics. 
 
TextBooks: 
 

S. No. Title Authors Edition Publisher 

1. Engineering Physics P. G. Kshirsagar & M. 
N. Avadhanulu 

Latest S. Chand Publications 

2. Engineering Physics R. K. Gaur, S. L. Gupta 4th Dhanpat Rai Publications 
3. Textbook of Engineering Physics S.O. Pillai, Sivakami Latest New Age International 

Publishers 
4. Applied Physics Navneet Gupta Latest Dhanpat Rai & Co. 
5. Concepts of Modern Physics Auther Beiser      7th Tata McGraw Hill 

6 अनपु्रयकु्‍तभौतिकी एम डी केला   दीपक प्रकाशन 

7  इंजीनियरिगं भौतिक विज्ञान आर के गर्ग, आलोक प्रकाश 
मित्तल  

 दीपक प्रकाशन 

 
ReferenceBooks: 
 

S. No. Title Authors Edition Publisher 

1. Optics A. Ghatak 4th McGraw Hill Education 
2. A Text Book of Optics N. Subrahmanyam & 

Brijlal 
25th  S. Chand Publication 

3. Solid State Physics S. O. Pillai 8th New Age International 
4. Introduction to Solid State 

Physics 
Charles Kittel 8th Wiley 

5. Semiconductor Optoelectronics: 
Physics and Technology 

J. Singh 2nd McGraw-Hill Inc 

6. Concept of modern physics Arther Beiser 6h  McGraw-Hill Inc 
7. Principles of Lasers O. Svelto 5th Springer Science & 

Business Media 
8. Lasers & Non-Linear Optics B. B. Laud 3rd New Age International 
9. Fibre Optics and Lasers Ajoy Ghatak and K. 

Thyagarajan 
1st Macmillan India Ltd. 



10. Principles of Physics Halliday, Resnick 
and walker 

11th Global Edition 

11. Modern Physics for Engineers S.P. Taneja 7th R. Chand 
12. Engineering Physics Malik and Singh 1st Tata McGraw Hill 
13. Unified Physics- Second & Third 

Yr. 
R. P. Goyal Latest Shiva Lal Agrawal and 

Company 
14 यनूिफाइड भौतिकी – द्वितीय एवं ततृीय 

वर्ष  
आर. पी. गोयल   शिवा लाल अग्रवाल एंड कंपनी  

 
 
E-resources/Web Sources: 
 

●​ https://archive.nptel.ac.in/courses/115/106/115106133/ 

●​ https://onlinecourses.nptel.ac.in/noc25_ph03/preview 

●​ https://onlinecourses.nptel.ac.in/noc25_ch04/preview 

●​ https://onlinecourses.nptel.ac.in/noc25_ph04/preview 

●​ https://onlinecourses.nptel.ac.in/noc25_ph06/preview 

●​ https://onlinecourses.swayam2.ac.in/nou25_ma02/preview 

 
 
 
 
 
 

https://archive.nptel.ac.in/courses/115/106/115106133/
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Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 
 

Semester-1st/2nd Branch:(Non-Circuit Branch) 
Subject:Engineering Physics - B Code: 3000A04AT015 
Maximum/Minimum- 
Passing marks:100/35 

Periods/week: 
L T P Ass. Hours 
3 -- -- 1/week 

 
Class Tests: 2 (Mandatory) Assignments: 2 (Minimum) 
Duration (ESE): 3 hours TotalCredits:3 

 
Course Objectives: 
1.​ What the concept of forces means in Physics and the significance of the net force on an object. 
2.​ To understand the nature of the different types of friction forces. 
3.​ The meaning of a body’s moment of inertia about a rotation axis. 
4.​ Learn how to use the relationship between total work and change in kinetic energy. 
5.​ To develop and understanding of the behavior of fluids as rest or in motion. 

 
UNIT I:FORCES AND FORCE SYSTEM; EQUILIBRIUM​ ​ ​ ​ ​ [09 Hrs] 
Idealisation of bodies, Rigid body, Force, Concept of resultant of several forces, Composition of forces (Polygon 
Law), Resolution of forces into components, Resultant of forces, Equilibrium of Concurrent forces in a plane, 
Moment of force, Varignon’s theorem, Constraint, Action and reaction, Types of support and support reaction, 
Free body diagrams, Parallel forces in a plane.​ ​ ​ ​ ​ ​ ​  
UNITII:FRICTION  ​      [09Hrs] 
(a)​ Introduction, Types of friction, limiting friction, Laws of friction, Static and dynamic friction, Angle of 

friction, Angle of repose, Cone of friction, Friction on body, Wedge friction, Belt and rope friction, Ladder 
friction, Belt drives, Ratio of tensions, Simple screw jack. 

(b)​ Principle of virtual work.​  
​  
UNITIII: MOMENT OF INERTIA                                                   ​ ​ [09Hrs] 
Introduction, Centre of gravity, Centre of mass, Moment of Inertia, Plate,Cylinder, Cone, Sphere.Centroid of one 
dimensional and twodimensional body, Centroid of composite sections.              Moment of inertia of rectangular 
plane, Polar moment of inertia, radius of gyration of area, Theorems of moment of inertia, Product of inertia of 
plane section, Displacement of axes, Rotation of axes, Principal axes, Principle of moment of Inertia.  
 
UNIT IV: KINETICS AND KINEMATICS​      [09Hrs] 
Rectilinear motion of Particle; Displacement, Velocity, Acceleration, D’Alembert’s principle, Work and energy 
principle, Principle of conservation of energy, Power, Impulse and Momentum principle. 
​  
UNITV: FLUID PROPERTIES​ ​ [09 Hrs] 
Introduction, Mass density, Weight density, Specific volume, Specific gravity, Viscosity, Ideal, Real, Newtonian 
and Non-Newtonian fluids, Compressibility and bulk modulus, Surface tension, capillarity, Vapour pressure, 
Pressure in fluid, Pascal’s law, Hydrostatic law, Manometry, Hydrostatic force on submerged plane and curved 
surface, Buoyancy and floatation 
 
CourseOutcomes: 
On successful completion of the course, the student will be able to: 
1.​ Apply basic concepts and analyze the system of forces. 



2.​ Analyze the systems by applying law of friction. 
3.​ Calculate the moment of inertia of bodies with various shapes. 
4.​ Analyze problem related to kinetics and kinematics of particles. 
5.​ Apply the key concepts of density, pressure, Buoyancy in fluids. 
 
TextBooks: 

S. No. Title Authors Edition Publisher 

1 University Physics Hugh D. Young Roger 
A. Freedman 

Latest Pearson Education Limited 

2 Engineering Mechanics A. K. Tayal Latest Umesh Publications 

3 Textbook of Fluid Mechanics and 
Hydraulic Machines 

R. K. Bansal Latest Laxmi Publications (P) Ltd. 

4 भौतिक शास्त्र (यांत्रिकी परिचय) ए. बी. भट्टाचार्य, अतन ु
गपु्ता  

प्रथम  
2021  

Khanna Book Publishing Co. 
(P) Ltd. 
AICTE अनशुसंित पाठ्यपसु्तक 
– मॉडल पाठ्यक्रम के अनसुार  
(AICTE e-कुम्भ मे उपलब्ध) 

5 इंजीनियरिगं यांत्रिकी  भानकर भारत गोकलदास प्रथम  
2021  

Khanna Book Publishing Co. 
(P) Ltd. 
AICTE अनशुसंित पाठ्यपसु्तक 
– मॉडल पाठ्यक्रम के अनसुार  
(AICTE e-कुम्भ मे उपलब्ध) 

 
ReferenceBooks: 

S. No. Title Authors Edition Publisher 

1. Engineering Mechanics S. Timoshenko and 
D.H. Young 

Latest Tata McGraw Hill 

2. Engineering Physics R. K. Gaur, S. L. 
Gupta 

4th Dhanpat Rai Publications 

3. Physics(Introductionto 
Mechanics) 

A.B. Bhattacharya 
 

1st 
2021 

Khanna Book Publishing Co. (P) 
Ltd. 
As per AICTE prescribed 
Syllabus under NEP-2020 
(Available in AICTE e-Kumbh) 

4 Engineering Mechanics: 
Principles of Statics and 
Dynamics 

R.C. Hibbeler Latest Pearson 

5 Engineering Mechanics 
(Statics and Dynamics) 

D.S. Kumar Latest S.K. Kataria& Sons 

6 Engineering Mechanics S. S. Bhavikatti and 
K.G. Rajeshkerappa 

Latest New Age International 

7 Unified Physics- First Year R. P. Goyal Latest Shiva Lal Agrawal and Company 
8  यनूिफाइड भौतिकी – प्रथम वर्ष  आर. पी. गोयल   शिवा लाल अग्रवाल एंड कंपनी  

 
E-resources/Web Sources: 

●​ https://archive.nptel.ac.in/courses/115/106/115106133/ 
●​ https://onlinecourses.nptel.ac.in/noc25_ph03/preview 
●​ https://onlinecourses.nptel.ac.in/noc25_ch04/preview 
●​ https://onlinecourses.nptel.ac.in/noc25_ph04/preview 
●​ https://onlinecourses.nptel.ac.in/noc25_ph06/preview 
●​ https://onlinecourses.swayam2.ac.in/nou25_ma02/preview 

 

https://archive.nptel.ac.in/courses/115/106/115106133/


 
 
 
 

Chhattisgarh Swami Vivekanand Technical University, 
Bhilai(CG) 

 
Course Objectives: 

●​ To impart a basic knowledge of electrical quantities such as current, voltage, power, energy 
and frequency.  

●​ To provide working knowledge for the analysis of single phase AC circuits. 
●​ To provide working knowledge of three phase AC circuits. 
●​ To introduce an analogy between electric and magnetic circuits. 
●​ To introduce the concepts of transformers and its importance. 

 
Course Outcomes:  

On successful completion of the course, the students will be able: 
CO1​ To apply network theorems to solve electrical DC circuits.  
CO2​ To formulate and solve complex AC circuits. 
CO3​ To draw phasor diagrams for 3 phase balanced star and delta connected systems.  
CO4​ To solve series and parallel magnetic circuits.  
CO5​ To explain the basic operating principle, types, operating performance of Transformers.   
 

Unit I: DC Circuits: [09 Hrs] 
Active, passive, unilateral, bilateral, linear, nonlinear, lumped and distributed networks, 
classification of voltage & current sources (Ideal, Practical, independent & dependent type), 
Kirchhoff’s Laws, mesh and nodal analysis, Superposition Theorem, Thevenins Theorem. 
(Only Independent Sources) 
 
Unit II: Single phase AC circuit: [09 Hrs] 
Pure Sinusoidal waveforms: frequency, cycle, time period, peak value, root mean square 
value, average value, form factor and peak factor, phasor representation of alternating 
quantities, concept of phase difference, the j operator, rectangular and polar form, solution 
of series, parallel and series-parallel RLC circuits, power (active, reactive and apparent 
power) and power factor. 
 
Unit III: Three Phase AC circuits: [09 Hrs] 
Introduction, phase sequence, balanced supply voltage and balanced load, connection of 
Three-phase Windings (delta and star connection): line and phase quantities, phasor 
diagrams, three phase power equations in balanced conditions. 
 
Unit IV: Magnetic Circuits: [09 Hrs] 

Semester- B.Tech-1st Sem (Common to all) Branch: Electrical Engineering 
Subject:  Basic Electrical Engineering       Code: 3000A05AT024 
 Maximum/Minimum Passing Marks:100/35 Periods/week: 

L T P    Ass. Hours 
3 - -      1/week 

 
Class Tests: 2 (Mandatory) Assignments: 2 (Minimum) 
Duration (ESE): 3 Hours Total Credits: 3 



Introduction, magneto-motive force (MMF), magnetic field strength, magnetic flux, 
reluctance, comparison of the electric and magnetic circuits. Solution of series and series – 
parallel, magnetic circuits (only for constant permeability materials) leakage flux and 
fringing. 
 
Unit V: Single phase Transformers: [09 Hrs] 
Introduction, principles of operation, Construction, EMF equation, classification of 
transformers, ideal transformer and practical transformer, phasor diagram at no load, 
Nameplate rating. Losses and Efficiency, Condition for Maximum Efficiency. 
 
 
 
Text Books: 

1.​ Basic Electrical Engineering D P Kothari & I J Nagrath, Mc Graw Hills, Fourth 
Edition. 

2.​ A Textbook of Electrical Technology, Volume I, B L Theraja, A K Theraja, S Chand  
& Company Ltd. 

3.​ A textbook of Electrical Technology, Volume II, B L Theraja, A K Theraja, S Chand 
& Company Ltd. 

4.​ Electric Machines, Ashfaq Hussain , Dhanpat Rai & Co. 
5. Basic Electrical Engineering in Hindi, Mr. M. L. Anwani, Dhanpat Rai & Co. (P) Ltd 

 
Reference Books: 
 

1.​ ABC of Electrical Engineering, Jain & Jain, Dhanpat Rai Publishing Company, 
Third Edition. 

2.​ Elements of Electrical Engineering, Sumant Singhare & Saurabh Singhare, 
Electronics Publication Engineering Series. 

3.​ Basic Electrical Engineering in Hindi ,  Dinesh Kumar Sharma, university books. 
 

 
***** 

 



 

Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 

Semester: B Tech. 1st Sem​ ​ ​ ​ ​ Branch: Common to All Branch  
Subject: Professional Communication Skills​ ​ ​ Code: 3000A06DT046 
Total Periods: 30                                                                            Credit: 2 
End Semester Exam: 50/17 ​ ​ ​ ​ ​ Assessment Hrs: 1/Week 
Teacher’s Assessment: 10​ ​ ​ ​ ​ Class Test: 10 
 

Course Objectives: 

●​ To enable students to communicate effectively to meet workplace challenges and exchange 
information beneficially in various professional contexts.  

●​ To make the students proficient in language and to use different communication skills and 
principles to function effectively in a professional settings. 

Course Outcomes 
On successful completion of the course, the student will be able to: 
CO1:​ Demonstrate a better understanding of the communication process by identifying, explaining, 

and applying current communication theories  
CO2:​ Develop clear and error-free language proficiency to communicate fluently in English 
CO3:​ Listen, read and comprehend and synthesize information from different sources and respond 

appropriately. 
CO4:​ Learn the various oral communication situations to elicit desired results. 
CO5:​ Understand and appropriately apply modes of expression in written communication and 

develop the fundamental skills and techniques in drafting effective business documents and 
research papers. 

 
Syllabus 

Unit 1: Fundamentals of Communication ​ ​ ​ ​ (6Hours) 
1.1​ Communication: Definition, Objectives, Process and Elements, Principles of Communication 
1.2​ Types: Verbal and Non-verbal Communication 
1.3​ Barriers to Communication: Physical, Mechanical, Linguistic, Psychological and Organizational 

Barriers 
 

Unit 2: Functional Grammar and Vocabulary Building ​ ​ (6 Hours) 
2.1 Vocabulary Building: Prefixes, Suffixes, Synonyms, Antonyms, Homonyms, Homophones, One 
Word Substitution 
2.2 Identifying Common Errors in English Usage:  Word to tenses, Articles, Prepositions, 
Collocations, Subject-Verb Agreement 
2.3 Misplaced Modifiers 
 
Unit 3: Reading and Listening Comprehension​ ​ ​ (6 Hours) 
3.1 Reading: Definition, Importance, Reading Speed, Strategies for effective reading (PSQ5R), 
Reading Comprehension.  
3.2 Listening: Definition, Difference between hearing and listening, Process, Purposes, Measures for 
Effective Listening, Barriers.  
3.3 Note-Making and Note-Taking, Information-Transfer 

 



Unit 4: Speaking Skills for Professional Contexts.​ ​ ​ (6 Hours) 
4.1 Speaking:Importance and Principles of Effective Speaking 
4.2PowerPointPresentation: Planning, Designing, Making the Speech/Presentation, Do’s and Don’ts  
4.3JobInterviews: Preparations, Ethics. 
 
Unit 5: Professional Writing Skills ​ ​ ​ ​ ​ (6 Hours)  
5.1 Business Letters: Elements, Types- Enquiry, Sending Quotations, Placing of Orders, Complaints, 
Reminders 
5.2 Applications for Job;Resume, CV. 
5.3Technical Report Writing: Characteristics, Components and their importance  
Suggested Readings  

S.No. Title Author(s) Publisher 

1 Business Correspondence and 
Report Writing R C Sharma & Krishna Mohan Tata McGraw Hill New Delhi 

2 Essentials of Business 
Communication J S Korlahalli &Rajendra Pal S Chand & Sons, Delhi 

3 Developing Communication Skills Krishna Mohan &Meera Banerjee Macmilan India Ltd 
4 CommunicationSkills Sanjay Kumar and PushpLata Oxford University Press 2011 
5 Practical English Usage Michael Swan OUP 1995 
6 Remedial English Grammar F T Wood Macmillan 2007 

7 Textbook of English Phonetics for 
Indian Students T Balasubramaniam Macmillan Publishers 2012 

8 Fundamentals of Communication 
Skills Chandra Shekhar Sharma Srijanpeeth Prakshan 

2023 

9 Interview Skills for Professionals Chandra Shekhar Sharma Srijanpeeth Prakshan 
2024 

10 Effective Technical 
Communication M Ashraf Rizvi Tata McGraw Hill New Delhi 

11 Fundamentals of Technical 
Communication Meenakshi Raman &Sangeetha Sharma Macmillan India Ltd 

12 
Technical Writing and 
Professional Communication for 
Non-native Speakers of English 

Thomas N Huckin and Leslie A Olsen McGraw Hill 
 

13 Communication Skills: Theory 
and Practice, Eighth Edition Prerna Malhotra, Deb DulalHalder Book Age Publications, New 

Delhi 

14 
English and Communication Skills 
for Students of Science and 
Engineering 

S.P. Dhanavel Orient Blackswan Ltd. 2009 

15 On Writing Well   William Zinsser Harper Resource Book. 20014 

16 Study Writing   Liz Hamp-Lyons and Ben Heasly Cambridge University Press 
2006 

17 Exercises in Spoken English. 
Parts. I-III.        CIEFL, Hyderabad Oxford University Press 

18  Word Power Made Easy Norman Lewis W R Goyal Publishers and 
Distributors 2009 

19 Enrich Your English, CIEFL SR Inthira and V. Saraswathi OUP 1997 

20 Longman Dictionary of Common 
Errors N.D. Turton and J.B. Heaton Longman 1998 

21 Oxford A-Z of English Usage ed. Jeremy Butterfield OUP 2007 
E-resources/Web Sources: 

●​ Communication Skills in English- https://onlinecourses.swayam2.ac.in/ntr25_ed62/preview 
●​ Soft Skills - https://onlinecourses.swayam2.ac.in/nou25_mg12/preview 
●​ English Communication - https://onlinecourses.swayam2.ac.in/cec25_hs31/preview 
●​ Learning English- https://archive.nptel.ac.in/courses/109/106/109106201/ 

 

https://onlinecourses.swayam2.ac.in/ntr25_ed62/preview
https://onlinecourses.swayam2.ac.in/nou25_mg12/preview
https://onlinecourses.swayam2.ac.in/cec25_hs31/preview
https://archive.nptel.ac.in/courses/109/106/109106201/
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     Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 
 

Semester-I Branch: All Branches 
Subject:Foundation Course on Ancient Indian Knowledge Systems Code: 3000A07ET046 
Total Theory Periods: 2 L: 2   T:0    P:0   Ass. Hours:01/week 
Total marks in End semester Exam: 50/17 
CT Marks : 10 

Total Credits: 2 
Teacher Assessment :10 

 
Course Objectives: 

1.​ To briefly introduce different areas of science and technology of Indian Knowledge System and Indian 

perspective of modern scientific view.   

2.​ To give a brief overview of selected areas of IKS, ancient mathematics, astronomy, literature and arts.  

3.​ To give foundation knowledge on work done by Indian Mathematicians in the fields such as Astronomy, 

Astrology, Geometry, Algebra, and Arithmetic etc 

CourseOutcomes: 

1.​ Student understand the various pramanas used in the Indian Knowledge System.  

2.​ Study of Indian Mathematics will reveal to students how it is embedded in Indian art, architecture, music, 

and religious practices, fostering a deeper understanding and appreciation of Indian culture.  

3.​ They have been introduced to some fields of IKS used in present Science and Technology. 

4.​ They have been introduced to some fields of IKS like Ayurved and Yoga. 

 

UNIT I: INTRODUCTION​ ​ ​ ​ ​ ​ ​ ​ (8Hours)  

Introduction to IKS & Its importance, Introduction & importance of IKS, Various IKS Systems, Shastra – 

Foundational Literature of Bharatvarsha, What is Shastra?, Importance of Shashtra,  Classification of 

Shashtra – Vaidic&Avaidic (with examples of important Literature), Bhartiya Education System and its 

philosophy, History of BES from Ancient to Modern, Domains of Education: Gurukul, Pathshala, 

Vidyalay, Vishvavidyalay. 

 

UNITII:FOUNDATIONAL CONCEPTS FOR SCIENCE AND TECHNOLOGY​ (7Hours) 

Linguistics, Introduction to Indian Mathematics, Indian Mathematicians and their Contributions, Number 

systems in India - Historical evidence, and Units of Measurement, Measurements for time, distance, and 

weight Knowledge: Framework and Classification. 

 

UNITIII: Science, Engineering and Technology in IKS`​ ​ ​ ​ (7Hours) 

Astronomy, Engineering and Technology: Metals and Metalworking, Science and technology heritage of 

India:  Physical structures Temples Watershed management Dyes, arts and perfume production. 



Surgical-techniques Shipbuilding.  

 

UNIT IV: AYURVEDA & YOGA IN IKS ​ ​ ​ ​ ​            (8Hours) 

Health, Wellness and Psychology, Ayurveda for Life, Health and Well-being: Introduction to Ayurveda: 

understanding Human body and Panchamahabhuta, the communication between body & mind, health 

regimen for wellbeing, introduction to yoga (raja yoga, astang yoga, gyan yoga). 

 

TextBooks: (Hindi and English language as per availability) 

1.​ B. Mahadevan, VinayakRajat Bhat, NagendraPavana (2022) Introduction to Indian Knowledge System: 

Concepts and Applications.  

2.​ A Concise History of Science in India – Bose, Sen &Subbarayappa- INSA Publications  

3.​ Dikshit, S. B. (1969, 1981). BharatiyaJyotish Sastra (in Marathi) Poona (1896). (Transl. RV Vaidya, 

Vol.1). New Delhi: Government of India Press.  

4.​ Sen, S. N., and Shukla, K. S. (Ed.) (2000). History of Astronomy in India, 2nd Revised Edition. New 

Delhi: Indian National Science Academy.  

 

ReferenceBooks: (Hindi and English language both) 

1.​ Iyengar, R. N. (2016) Astronomy in Vedic texts, History of Indian Astronomy, A Handbook - Volume 

brought out on the occasion of IX International Conference on Oriental Astronomy November 14–18.  

2.​ Encyclopedia of Classical Indian Sciences- Roddam Narasimha, Universities Press  

3.​ NCERT Modules of KPTI  

4.​ Thompson R.L. (2007) The Cosmology of the BhāgavataPurāṇa (First Indian Edition) MLBD Publn. 

Delhi.  

5.​ Altekar A.S. (1944) Education in Ancient India.  

6.​ Agrawala V.S. (1953) India as known to Panini.  

 

 
 



 
 
 

Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 

 
Course Objectives: 

1.​ To understand the basic components and functionality of computer systems. 
2.​ To develop proficiency in using operating systems and essential software tools. 
3.​ To gain hands-on experience in basic programming concepts, including variables, loops, and decision-making 

statements. 
4.​ To learn techniques for handling data, working with files, and managing exceptions. 
5.​ To build a foundation for applying computational thinking to solve real-world problems. 

 
List of Experiments: (Each student is required to perform a minimum of 15 experiments.) 

1.​ Disassembly of computer and identify the front and rear panel ports and connectors on a PC cabinet Open the 
cabinet and identify various motherboards components, connector’s slots, ports (USB, VGA, DVI, and HDMI), 
cables and Connectors. 

 
●​ Identify Motherboard Components and connections. CPU (Processor) RAM (Memory) Hard Drive 

Connections Mechanical vs. Solid State Drives ROM Drives Graphic Cards, Sound Cards, Install & configure 
add-on cards 

●​ Check various front panel connections on motherboard (power switch, reset switch and HDD Led).  
●​ Check power and reset switch connection. Replace faulty power switch from cabinet and assemble a new one. 
●​ Check DDR3 and DDR4 RAM’s FSB. Insert it on memory slot. Test and understand various beep sounds in 

case of trouble. 
●​ Find the CMOS/ROM BIOS chip on mother board 
●​ Install a Hard Drive. Identify and check data and power cable and SATA and SACH ports in motherboards 
 

2.​ Motherboard Installation - Removing the Motherboard carefully and Install it again. 
●​ Removing the Processor, Installing the Processor. Understand and identify various different processor sockets 
●​ Find the CMOS Battery. Test it with multimeter. Replace it. 
●​ Boot the PC through a BOOTABLE DVD of OS.  
●​ Partition the disk, Format the drive.  

 
3.​ Install Windows windows 11/Ubuntu/Mint/Fedora or other  

●​ Practice keyboard shortcuts of mouse activities. 
●​ How to Backup/Restore your Windows partition with the bootable image 
●​ Open windows explorer and find different drives, files and folders, their size and other properties.  
●​ Use Power shell commands Open Device Manager, find various devices and install appropriate driver 

software (audio, video, chipset, LAN, WLAN, printer and monitor). Use & practice WMIC console. 
 

4.​ Basic  OS operations -  MOUSE OPERATIONS, Utilities and Accessories, Installation, and configuration of OS 
 

Semester- 1st – B. Tech Branch: Common to all 
Subject: Fundamentals of Computers & IT Lab Code: 3000A02CL022 
Maximum/Minimum-Passing marks: 40/20 
Teacher Assessment: 20 
Teacher Hours: 60 
 

Periods/week: 
L T P Ass. Hours 
- - 04 1/week 

 Credit: 02 



5.​ Experimenting with internal and external DOS Commands - INTERNAL COMMANDS: SET, PATH, DIR, 
MD, CD, CD..,BREAK EXTERNAL COMMANDS: ATTRIB,TREE,CHKDSK,APPEND 
 

6.​ Write a business letter to company’s higher authority for assigning project proposal using different types of 
formatting in MS word  
Steps: 

●​ Select blank document 
●​ Save file with appropriate name  
●​ Type letter 
●​ Format subject of letter to highlight it  
●​ Select entire text to make it aligned and justified 
●​ Apply border to page 
●​ Add bullets to your documents attached list 
 

7.​ Create a calendar in MS word and display specific holiday list of the same month 
Steps: 

●​ Open blank document 
●​ Save file with appropriate name 
●​ Go to insert tab > select table  
●​ MS Word gives option to add pre-defined templates for calendars Go to quick tables > Select a template 

for calendars 
●​ Calendar will appear on the screen 
●​ Now add the specific holidays in the calendar, by typing the name of the off For e.g. 2nd October- Gandhi 

Jayanti (You can change the month and days as per your requirement.) 
●​ Marked off cab be formatted with different color Home tab> Font group> Font color/Font highlight 

option 
 

8.​ Create a Time table in MS Word 
Steps: 
1.​ click on the start button on your desktop> select MS Office > select MS Word > MS word will open, select 

blank document 
2.​ Save your file with an appropriate name. Go to File menu > Save as> select the file name and location and 

click save. 
3.​ Go to insert tab> Select tables 
4.​ Select 7x7 Table 
5.​ Fill in the required details such as timings, Break and subjects. 
6.​ In the tables Merge the cells for showing ‘break’  Select the columns to be merged 
7.​ Mark Labs period with Desired colorHome tab > Font group > desired color from font color option 
8.​ Fill the break with different color Home tab > Font group > desired color from text highlight color option 
9.​ Write course detail on top of the time table and add shade to the course details on the top Home tab> 

paragraph group > borders and shading> Shading 
 

9.​ Create your personal CV using Different types of Bullet and Numbering 
Steps:  
1.​ Click on the start button on your desktop> select MS Office > select MS Word > MS word will open, select 

blank document 
2.​ Save your file with an appropriate name. Go to File menu > Save as> select the file name and location and 

click save. 
3.​ Go to Insert tab > Select page number option in header and footer group> select the position of page number 

to the bottom of the page and Alignment to Center > Click Ok. 
4.​ Go to Insert tab > Select Table option > from insert table option, choose 2 columns and 1row.In the first 

column, enter your name. Go to home tab, font group> increase the font size, make it bold In the second 



column, type your personal details- Contact number and e mail ID. Go to home tab, font group> increase the 
font size, change the font style to italics and color to green for your mobile number and E mail ID. 

5.​ Create another table to fill in the educational qualification, skills and career objective. Go to insert tab> select 
tables> choose 3 row and 1 column Define career objective in first column Educational qualification in 2nd  
column Skills in 3rd column 

6.​ Go to home tab select different bullets and numberings for mentioned skills and subskills 
7.​ Also apply bullets to the headings 
8.​ Bold the heading ‘career objective’ and increase the font size 
10.​ Select the heading ‘career objective’> go to home tab > select format painter by a double 
11.​ Click> copy formatting to other heads- educational qualification and skills. 
9.​ Within educational qualification table, insert another 4x4 table and fill your details of school and college 

percentage and year of passing. 
10.​ select the table with name and contact details> go to home page> borders and shading>select green border 

with 3 weight. 
 

11.​ Create a word Doc using Smart -Art 
Steps 

1.​ click on the start button on your desktop> select MS Office > select MS Word > MSword will open, select 
blank document 

2.​ Save your file with an appropriate name. Go to File menu > Save as> select the filename and location and 
click save. 

3.​ Place the insertion point in the document where you want the SmartArt graphic to appear. 
4.​ From the Insert tab, select the SmartArt command in Illustrations group. 
5.​ A dialog box will appear. Select a category on the left (Hierarchy or list or any other option), choose the 

desired Smart Art graphic, then click OK 
6.​ The SmartArt graphic will appear in your document. 
7.​ Select the SmartArt graphic. The SmartArt task pane will appear to the left.  
8.​ Enter text next to each bullet in the task pane. The text will appear in the graphic and will resize to fit inside 

the shape. 
9.​ Select the smart art, on the tabs you will see 2 options- Design and Format, then click the 
10.​ Design tab or Format tab. You can change the color, layout and style of the SmartArt, text style, shape fill etc. 

from these 2 tabs 
 

12.​ Create a word doc and show different types of formatting and display the content of the document in 2 
column format. 

Steps 
  

1.​ Click on the start button on your desktop> select MS Office > select MS Word > MS word will open, select 
blank document 

2.​ Save your file with an appropriate name. Go to File menu > Save as> select the filename and location and 
click save. 

3.​ Write the content that you want to display in 2 column format 
4.​ You can add the pictures to enhance your document Insert> pictures>clipart/ pictures from your computer 
5.​ Now select the text that you want to display in 2 column format. 
6.​ Go to layout tab > page set up group > select column option 
7.​ Various options such as 2 column, 3 column, multi column will appear Choose 2 column option 
8.​ For formatting the text, select the headings in your text Go to home tab> font group> mark B for bold, 

highlight the headings with desired color, select U for underlining the text Now, go to paragraph group and 
add bullets to the heading 

9.​ Add page border Go to borders and shading tab in paragraph group of home tab > select page border, add 
weight to it to increase the width 

 
 



 
13.​ Create a word document and encrypted the document 

Microsoft Word 2007 includes a feature that allows you to password-protect documents from changing content. 
You encrypt a document by setting a password that another user will not be able to open it. 

Steps: 
1.​ click on the start button on your desktop> select MS Office > select MS Word > MS word will open, select 

blank document 
2.​ Save your file with an appropriate name. Go to File menu > Save as> select the file name and location and 

click save. 
3.​ Click the Office button and move the cursor over the Prepare option. 
4.​ Click Encrypt Document in the menu that appears.5. 
5.​ In the pop-up window, type the password to encrypt the document, and click OK. A new message box will 

appear, asking you to retype the password. Re-enter and click OK. You have successfully encrypted your 
document. 

6.​ Try to include at least one number and one non-alphanumeric character in your password to make it harder to 
crack. 

7.​ Encrypted document can contain any information as per the user. 
8.​ Note: For versions of MS word that do not have prepare option, follow the following: Start button > Save as> 

to the left of save button, Tool option appears. Select it. Then select General options > Encryption option asks 
for password > Enter the password 
 

14.​ Mail Merge using MS Word  
Steps 

1.​ click on the start button on your desktop> select MS Office > select MS Word > MS word will open, select 
blank document 

2.​ Save your file with an appropriate name.  Go to File menu > Save as> select the file name and location and 
click save. 

3.​ Go to mail merge option in mailing tab2. 
4.​ Select step by step mail merge wizard3. 
5.​ Select the document type- letters Click next: starting document4. 
6.​ Select the document- Use the current document5. 
7.​ Select recipients. Click Type a new list. 
8.​ Click Create Type the recipient list- Name, address and add ward name option. 
9.​ Click ok, once list is complete. It gives you an option to save the list. Save the list by any name in your 

computer. 
10.​ Write your letter 
11.​ Add greetings, address and ward name in the letter 
12.​ Preview your letters 
13.​ Complete the merge 
 

15.​ Create a Power point presentation 
Steps 

1.​ Click the Start button. 
2.​ Click All Programs option from the menu. 
3.​ Search for Microsoft Office option 
4.​ Search for Microsoft PowerPoint within Microsoft office 
5.​ click the option, MS PPT will open 
6.​ Click blank presentation 
7.​ Selecting a Theme for Your Presentation on the Design tab, in the Themes group, click the document 

theme that you want, or click more to see all available document themes. 
8.​ Choosing a Layout for New Slide on the Home tab, in the Slides group, click Layout. 
9.​ In the slide, as per the layout selected, write title of the slide in title placeholder 
10.​ Write the content of your presentation in the content placeholder 
11.​ Insert related pictures from the insert menu >Pictures 



12.​ Insert Chart Go to insert menu> chart> bar chart> select the desired design of chart In excel sheet that will 
open with chart, edit the data as per your presentation 

13.​ Add animations to your slides Animation tab> Animation group> select the animation style  
 

16.​ Create power point presentation with including Animation and types of Graph plots. 
Steps: 
1.​ Click the Start button. 
2.​ Click All Programs option from the menu. 
3.​ Search for Microsoft Office option 
4.​ Search for Microsoft PowerPoint within Microsoft office 
5.​ Click the option, MS PPT will open 
6.​ Click blank presentation 
7.​ Selecting a Theme for Your Presentation 
8.​ On the Design tab, in the Themes group, click the document theme that you want, or click more to see all 

available document themes. 
9.​ Choosing a Layout for New Slide on the Home tab, in the Slides group, click Layout. 
10.​ In the slide, as per the layout selected, write title of the slide in title placeholder 
11.​ Write the content of your presentation in the content placeholder 
12.​ Insert related pictures from the insert menu >Pictures 
13.​ Insert Chart Go to insert menu> chart> bar chart> select the desired design of chart in excel sheet that will 

open with chart, edit the data as per your presentation 
14.​ Add animations to your slides Animation tab> Animation group> select the animation style. You can apply 

animation to text as well as pictures 
15.​ Click ‘all at once or one by one’ to animate list of text 
16.​ Click ‘animation pane’ in animation tab to see all the animations applied to text and slides. 

 
 

17.​ Create an electronic spread sheet which shows the attendance, Assignment and sessional marks of Students. 
Use formula to calculate avg. assignment marks, Avg Sessional marks and total marks 
Steps: 
1.​ Go to start button> MS office > MS excel > Blank sheet 
2.​ Start typing the data heading- student’s name, marks, roll no., attendance, sessional and assignment marks in 

different columns 
3.​ In a column, add heading ‘average marks’ and ‘total marks’ 

 
4.​ Now under the heading average, use formula: '=' average (select the range of cells containing marks of 

the students {attendance, sessional and assignment marks student wise}) 
5.​ Now under the heading total marks, select all marks, student wise and use sum formula to add all the marks 

{= sum (cell range)} 
6.​ We have obtained the average and total marks of the students 
 

18.​ Create an electronic spread sheet which shows the attendance, Assignment and sessional marks of Students. 
Use formula to calculate avg. assignment marks, Avg Sessional marks and total marks. Display the 
percentage in column and pie chart 
Steps: 
1.​ Go to start button> MS office > MS excel > Blank sheet 
2.​ Start typing the data heading- student’s name, marks, roll no., attendance, sessional and assignment marks in 

different columns 
3.​ In a column, add heading ‘average marks’ and ‘total marks’ 

  
 



4.​ Now under the heading average, use formula: '=' average (select the range of cells containing marks of 
the students {attendance, sessional and assignment marks student wise}) 

5.​ Now under the heading total marks, select all marks, student wise and use sum formula to add all the marks 
{= sum (cell range)}  

6.​ We have obtained the average and total marks of the students. 
7.​ Now add another column ‘Percentage’ and ‘Total marks (15)’ 
8.​ In percentage column, to calculate percentage, type = (select marks obtained cell) /(Select total marks 15 cell) 
9.​ Select the data> go to insert> Charts> Select the suitable type of chart- pie and column chart to represent the 

percentage. 
10.​ Chart will appear. Now right click and select ‘select data’ option to choose percentage and student’s name 

option specifically by selecting columns with relevant data (Name of the student and percentage) 
 
 
Course Outcomes: 

1.​ Students will gain a solid understanding of basic computer hardware, software, and operating systems. 
2.​ Students will become proficient in using MS Office tools for word processing, spreadsheets, and presentations. 
3.​ Students will develop the skills to write, document, and present their work effectively during project development. 
4.​ Students will build a strong foundation in programming and computational thinking for solving real-world 

problems. 
5.​ Students will gain awareness of and familiarity with online applications and services related to Digital India 

initiatives. 
 
E-resources/Web Sources: 
 

●​ Introduction to computer science-https://archive.nptel.ac.in/courses/106/101/106101238/ 

 

https://archive.nptel.ac.in/courses/106/101/106101238/


 
 
 
 
 
 
 

Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 
Semester: 1st/2nd Branch: Non-Circuit Branch 
Subject:Engineering Physics Lab - B Code: 3000A04AL015 

Maximum/Minimum- 
Passing marks:40/20 
Teacher Assessment: 20 

Periods/week: 
L T P Ass. Hours 
-- -- 2 - 

 
 TotalCredits:1 

 
Course Objectives: 
1.​ To study the surface tension of water by using Jaeger’s and capillary rise methods. 
2.​ To calculate acceleration due to gravity and the moment of inertia of a flywheel. 
3.​ To determine the wavelength by laser diffraction, and the horizontal component of earth’s magnetic field-H. 
4.​ To calculate the coefficient of viscosity by different methods. 
5.​ To analyze thermal conductivity and the mechanical equivalent of heat. 

 
LIST OF EXPERIMENTS 
[BRANCHES:CIVIL/MECHANICAL/MECHATRONICS/BIO-PHYSICS/CHEMICAL/BIOTECHNOL
OGY] 
 

1.​ To determine the surface tension of water at laboratory temperature by Jaeger’s Method. 
2.​ To determine the surface tension of water by capillary rise method. 
3.​ To accurately measure the acceleration due to gravity with the help of a reversible physical pendulum (or 

bar pendulum). 
4.​ To determine the moment of inertia of a flywheel about its own axis of rotation. 
5.​ To determine wavelength of a given laser source using a diffraction grating.  
6.​ To determine the value of H, the horizontal component of earth’s magnetic field by deflection and 

vibration magnetometer. 
7.​ To determine the coefficient of viscosity by Stoke’s method. 
8.​ To determine the coefficient of viscosity by Poiseuille’s method. 
9.​ To determine thermal conductivity of a bad conductor by LEE’s disk method. 
10.​ To determine the mechanical equivalent of heat by Calender-Barnes method. 

 
CourseOutcomes: 
Students will be able to: 
1.​ Determine the surface tension of water using different methods. 
2.​ Calculate acceleration due to gravity and the moment of inertia of a flywheel. 
3.​ Determine the wavelength of light using the laser diffraction method and calculate the horizontal component 

of Earth’s magnetic field-H. 
4.​ Apply various methods to calculate the coefficient of viscosity and understand the principles behind each 

technique. 
5.​ Analyze the thermal conductivity of materials and determine the mechanical equivalent of heat. 

 
 
 
 



 
TextBooks: 
 

S. No. Title Authors Edition Publisher 
1. A Textbook of Engineering 

Physics Practical 
R. Das, C. S. Robinson, 
Rajesh Kumar and 
Prashant Kumar Sahu 

Second University Science Press 
(Laxmi Publication), New 
Delhi 

2. Experiments in Engineering 
Physics 

M.N. Avadhanulu, A.A. 
Dani, P.M. Pokley 

Latest S. Chand Publications, New 
Delhi. 
 

 

 
ReferenceBooks: (Hindi and English language both) 
 
E-resources/Web Sources: 

●​ https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9
ASK 

 
 
 
 

https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9ASK
https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9ASK


 
 
 
 
 
 
 
 
 

Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG). 

 
Course Course Objectives: 

1.​ To study the interaction of light with optical fibers and analyze the diffraction of a laser beam. 
2.​ To analyze the characteristics of solar cells, photoresistors, and photocells. 
3.​ To examine the properties of a semiconductor diode by determining the forbidden energy gap and studying 

its characteristic curves. 
4.​ To determine the specific resistance of a wire and the frequency of an A.C. source accurately. 
5.​ To know the concepts of interference and diffraction using bi-prism and grating experiments respectively. 

 
LIST OF EXPERIMENTS 
BRANCHES: IT/CSE/CS(A.I.)/CS(D.S.)/E&TC/EE/EEE/E&I 

 
1.​ To determine the Numerical Aperture (NA) of an optical fiber. 
2.​ To determine the wavelength of a given LASER source using a diffraction grating. 
3.​ To study characteristics of a solar cell. 
4.​ To study the characteristics of a Photo resistor. 
5.​ To determine the value of plank’s constant (h) using a photocell. 
6.​ To determine the forbidden energy gap of a P-N junction diode. 
7.​ To study the characteristic curve of a P-N junction diode. 
8.​ To determine the specific resistance of a given wire using a carry foster bridge. 
9.​ To determine fringe width of an interference pattern using Fresnel’s bi-prism. 
10.​ To determine the frequency of A.C. mains by a Sonometer. 
11.​To determine the resolving power of plane transmission grating. 
12.​ To determine the radius of curvature of plano convex lens by Newton’s rings method. 

 
Course Outcomes: 
Students will be able to: 

1.   Demonstrate an understanding of the interaction of light with optical fibers and the diffraction 
      principles applicable to laser beams. 
2.  Evaluate the performance and characteristics of solar cells, photoresistors, and photocells in various 

applications. 
3. Determine the forbidden energy gap of semiconductor diodes and analyze their characteristic curves. 
4.   Calculate the specific resistance of a wire. Measure the frequency of an A.C. source  
5.   Calculate the fringe width using bi-prism and resolving power of grating. 

 

Semester: 1st/2nd Branch: Circuit Branch 
Subject: Engineering Physics Lab - A Code: 3000A03AL015 

Maximum/Minimum- 
Passing marks:40/20 
Teacher Assessment: 20 

Periods/week: 
L T P Ass. Hours 
-- -- 2 - 

 
 Total Credits:1 



 



 
Text Books: 
 

S. No. Title Authors Edition Publisher 
1. A Textbook of Engineering 

Physics Practical 
R. Das, C. S. Robinson, 
Rajesh Kumar and 
Prashant Kumar Sahu 

Second University Science Press 
(Laxmi Publication), New 
Delhi 

2. Experiments in Engineering 
Physics 

M.N. Avadhanulu, A.A. 
Dani, P.M. Pokley 

Latest S. Chand Publications, New 
Delhi 

 
E-resources/Web Sources: 

●​ https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9ASK 
 
 
 
 
 

https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9ASK


 

 

Chhattisgarh Swami Vivekanand Technical University, Bhilai 

Semester- B. Tech–1st Sem (Common to all) Branch: Electrical Engineering 
Subject:  Basic Electrical Engineering Lab Code: 3000A05AL024 

Maximum/Minimum-Passing marks: 40/20 
Teacher Assessment: 20 

Periods/week: 
L T P Ass. Hour 
- - 2 -​               

Duration (ESE): Total Credits: 1 
 
Course Objectives: 
1.​To provide comprehensive idea about D C circuits, theorems and their applications.  
2.​To provide fundamental and working knowledge for the analysis of AC circuits. 
3.​To introduce students with fundamental concepts of polyphase electrical system. 
4.​To impart basic ideas of magnetic circuits and their significance in Electrical Engineering.  
5.​To highlight the importance of transformers and its impact on global and societal context.  

 
Course Outcomes:  
On successful completion of the course, the student will be able to: 
1.​Analyze DC circuits using KVL, KCL, Thevenin’s and Superposition theorem.  
2.​ Illustrate the basics of R, L, C circuit elements and can provide solution for ac circuits 

along with phasor diagram.  
3.​Comprehend the concept and applications of polyphase electrical system. 
4.​Understand and solve the problem pertaining to magnetic circuits.  
5.​Understand the construction, working and principle of single phase Transformer.  

 

List of Experiments    

S.N List of Experiments 
1. Verification of Kirchhoff’s Voltage Law and Kirchhoff’s Current Law. 
2. Verification of Thevenin`s Theorem and Superposition Theorem. (C) 
3. To determine V– I characteristics of Incandescent lamp. 
4. To measure R and L of choke coil.   
5. To observe and measure the voltage and current waveform of the series RLC circuit using 

DSO and Multi-meter. To find the voltage ,current , power and power factor of the series 
RLC circuit and  draw the phasor diagram.(C) 

6. To observe and measure the voltage and current waveform of the parallel RLC circuit 
using DSO and Multi-meter. To find the voltage, current, power and power factor of the 
series RLC circuit and draw the phasor diagram.  

7. Connection of three phase load in Star configuration and measurement of all Line and 
Phase quantities of the circuit.  Also observe it`s waveform pattern using DSO. 

8. Connection of three phase load in Delta configuration and measurement of all Line and 
Phase quantities of the circuit. Also observe it`s waveform pattern using DSO.   

9. To plot the B-H curve of a magnetic material. 
10. Study of single phase transformer (Name plate, tapping, rating) and determination of 

efficiency by Direct Loading. (C) 
11. To study core and shell type transformers. 
12. To perform ratio test and polarity test of a single phase transformer. 
Text Books: 

1.​ Basic Electrical Engineering D P Kothari & I J Nagrath, Mc Graw Hills, Fourth Edition. 



2.​ A textbook of Electrical Technology, Volume I and II B L Theraja, A K Theraja, S Chand  
& Company Ltd 

3.​ Electric Machines, Ashfaq Hussain, Dhanpat Rai & Co. 
4.​ Laboratory manual for Electrical Machines. D P Kothari, B.S. Umre. Wiley 

 
Reference Books: 
 

1.​ ABC of Electrical Engineering, Jain & Jain, Dhanpat Rai Publishing Company, Third 
Edition. 

2.​ Elements of Electrical Engineering, Sumant Singhare & Saurabh Singhare, Electronics 
Publication Engineering Series. 

3.​ Basic Electrical Engineering (with Lab Manual) by S.K. Sahdev 
 

https://www.amazon.in/s/ref=dp_byline_sr_book_1?ie=UTF8&field-author=S.K.+Sahdev&search-alias=stripbooks


 
 
 

CHHATTISGARH SWAMI VIVEKANAND TECHNICAL UNIVERSITY, 
BHILAI (C.G.) 

 
 

Semester- 1st  Sem- B.Tech Branch: Common for All 
Subject: Sports and Yoga Code: 3000A06FL046 

Maximum/Minimum-Passing marks: - 
Class Test Marks: - 
Teacher Assessment: 30 
Teaching Hours: 30 

Periods/week: 
L T P Ass. Hours/week 
- - 2 - 
 

Class Tests: 0 Assignments: - 
Duration (ESE): - Total Credits: - 

 
Course Objectives 
  I.            To develop both physical fitness and mental well-being through an integrated approach. 
II.            To help build strength, stamina, teamwork, and agility 
 III.            To enhance mental and physical well being through yoga 
  IV.            To create self-inspiration-driven academiccally sound youth who can balance, focus, and manage stress. 
V.            Encourage a healthy, active lifestyle and promote overall personal development in body, mind and spirit. 
 
Sports 
The sports component of this course focuses on enhancing physical fitness, coordination, and teamwork through 
a variety of structured games and activities. Participants will engage in individual and team sports such as 
athletics, badminton, volleyball, and basketball, aimed at building endurance, agility, and strategic thinking. 
Emphasis will be placed on sportsmanship, discipline, and the development of motor skills, while also 
promoting an active and healthy lifestyle through regular participation and practice. 
 
Yoga 
The yoga component introduces learners to the fundamentals of asanas (postures), pranayama (breathing 
techniques), and relaxation practices that support both physical and mental well-being. Sessions will cover basic 
standing, sitting, and supine postures to improve flexibility, balance, and core strength, alongside breathing 
exercises for stress relief and mental clarity. The course will encourage mindful movement, body awareness, 
and the integration of short yoga routines into daily life for long-term health benefits. 
 
 
 
 
 
 
 
 
 
 



 
CHHATTISGARH SWAMI VIVEKANAND TECHNICAL UNIVERSITY, 

BHILAI (C.G.) 
 

 

Semester- 1st Sem- B.Tech Branch: Common for All 
Subject: Social Service/Community Services Code: 3000A07FL046 

Maximum/Minimum-Passing marks: - 
Class Test Marks: - 
Teacher Assessment: 30 
Teaching Hours: 30 

Periods/week: 
L T P Ass. 

Hours/week 
- - 2 - 
 

Class Tests: 0 Assignments: - 
Duration (ESE): - Total Credits: - 

 
Course Objectives 
 
This course aims to develop a sense of social responsibility, empathy, and civic engagement among first-year 
engineering students. It encourages them to understand community needs, work collaboratively on real-life 
problems, and contribute meaningfully to society. Through hands-on participation in community development 
projects, students will learn how engineering knowledge can address local challenges, promote sustainable 
solutions, and foster inclusive growth. The course also focuses on building soft skills like teamwork, 
communication, and leadership while instilling ethical values. 
 
 
 
Syllabus & Activities: 
The course will include orientation sessions on social issues such as sanitation, environmental conservation, 
digital literacy, rural development, and health awareness. Students will engage in fieldwork with NGOs, local 
self-government bodies, or campus-based community projects. Activities may involve cleanliness drives, tree 
plantation, basic technology workshops for the underprivileged, assisting in disaster relief preparedness, or 
creating low-cost solutions for local problems. The program will conclude with a reflective report and 
presentation, where students analyze their contribution, challenges faced, and lessons learned for future 
community-oriented work. 
 
 
 
 
 
 



 
 
 

 
Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 

 

Semester- 1st Branch:CSE/CyberSecurity/CST/IT/AIML/AI/DS/AI
DS/Computer Science and Engg (IoT)/ Computer 
Engineering (Software Engg.) 

Subject: Python for Problem Solving & Logic Building Code: 3022A01CT022 
Maximum/Minimum-Passing marks: 100/35 
 

Periods/week: 
L T P Ass. Hours 
03 01 -- 1 /Week 

 
Class Tests: 2 (Mandatory) Assignments: 2 (Minimum) 
Duration (ESE): 3 hours Total Credits: 04 

 
Course Objectives:  

1.​ To understand the basics of algorithmic problem solving.  
2.​ To learn to solve problems using Python conditionals and loops.  
3.​ To define Python functions and use function calls to solve problems.  
4.​ To use Python data structures – lists, tuples, dictionaries to represent complex data.  
5.​ To do input/output with files in Python. 

 
UNIT I: Fundamentals of Computing – Identification of Computational Problems -Algorithms, building 
blocks of algorithms (statements, state, control flow, functions), notation (pseudo code, flow chart, 
programming language), algorithmic problem solving, simple strategies for developing algorithms 
(iteration, recursion). Illustrative problems: find minimum in a list, insert a card in a list of sorted cards, 
guess an integer number in a range, Towers of Hanoi. 
 

(12 Hrs) 

UNIT II: Python interpreter and interactive mode, debugging; values and types: int, float, boolean, string, 
and list; variables, expressions, statements, tuple assignment, precedence of operators, comments; 
Illustrative programs: exchange the values of two variables, circulate the values of n variables, distance 
between two points. 

(12 Hrs) 

 
UNIT III:  Control Flow Functions and String Conditionals: Boolean values and operators, conditional 
(if), alternative (if-else), chained conditional (if-elif-else); Iteration: state, while, for, break, continue, pass; 
Fruitful functions: return values, parameters, local and global scope, function composition, recursion; 
Strings: string slices, immutability, string functions and methods, string module; Lists as arrays. 
Illustrative programs: square root, gcd, exponentiation, sum an array of numbers, linear search, binary 
search 

 
 

(12 Hrs) 

 
UNIT IV: Lists: list operations, list slices, list methods, list loop, mutability, aliasing, cloning lists, list 
parameters; Tuples: tuple assignment, tuple as return value; Dictionaries: operations and methods; 
advanced list processing – list comprehension; Illustrative programs: simple sorting, histogram, Students 
marks statement, Retail bill preparation. 
 

 
(12 Hrs) 

UNIT V: Files and exception: text files, reading and writing files, format operator; command line 
arguments, errors and exceptions, handling exceptions, modules, packages; Illustrative programs: word 
count, copy file, Voter’s age validation, Marks range validation (0-100). 
 

(12 Hrs) 



 
 
 
 

Course Outcomes:  
1.​ Develop algorithmic solutions to simple computational problems.  
2.​ Develop and execute simple Python programs.  
3.​ Write simple Python programs using conditionals and looping for solving problems.  
4.​ Decompose a Python program into functions.  
5.​ Read and write data from/to files in Python programs. 

 
Text Books:  

1.​ Allen B. Downey, “Think Python: How to Think like a Computer Scientist”, 2nd Edition, O’Reilly 
Publishers, 2016. 

2.​ “Python for Everyone” Saurabh Chandrakar, Dr. Nilesh Bhaskarrao Bahadure 

Reference Books:  
1.​ Paul Deitel and Harvey Deitel, “Python for Programmers”, Pearson Education, 1st Edition, 2021.  
2.​ G Venkatesh and Madhavan Mukund, “Computational Thinking: A Primer for Programmers and Data 

Scientists”, 1st Edition, Notion Press, 2021. 
3.​ “Programming Techniques using Python” Saurabh Chandrakar, Dr. Nilesh Bhaskarrao Bahadure 
4.​ https://www.python.org/ 6. Martin C. Brown, “Python: The Complete Reference”, 4th Edition, Mc-Graw 

Hill, 2018. 
 
E-resources/Web Sources: 
 

●​ Problem solving Aspects and Python Programming- https://youtu.be/IWrzrRKiQNo 
https://onlinecourses.swayam2.ac.in/cec25_ma02/preview 

●​ Programming in Python- https://onlinecourses.swayam2.ac.in/cec22_cs20/preview 
 

हिदंी पसु्तक: 
1- प्रोग्रामिगं एंड प्रॉब्लम सॉल्विगं थ्र ूपाइथन ल ैंग्वेज (Programming and Problem Solving Through Python 

Language)(Hindi & English Combined) Prof. Satish Jain (प्रो. सतीश जनै), Shashi Singh (शशि सिहं) 
 

 
 
 
 
 

https://youtu.be/IWrzrRKiQNo
https://onlinecourses.swayam2.ac.in/cec25_ma02/preview
https://onlinecourses.swayam2.ac.in/cec22_cs20/preview


​ ​ ​ ​ ​ ​ ​  
 
 

 
 

Chhattisgarh Swami Vivekanand Technical University, Bhilai (CG) 
 

 

Semester- 1st   
Subject: Python for Problem Solving & Logic 
Building Lab 

Branch:CSE/CyberSecurity/CST/IT/AIML/AI/DS/A
IDS/Computer Science and Engg (IoT)/ Computer 
Engineering (Software Engg.) 

Maximum/Minimum-Passing marks:40/20 Code: 3022A01CL022 
Teacher Assessment :20 
Credit :01 

Periods/week: 
L T P Ass. Hours 
- - 02        - 

 

 
Course Objective:  
 
1.​ To write, test, and debug simple Python programs.  
2.​ To implement Python programs with conditionals and loops.  
3.​ Use functions for structuring Python programs.  
4.​ Represent compound data using Python lists, tuples, and dictionaries.  
5.​ Read and write data from/to files in Python. 

 
List of Experiments: (Each student is required to perform a minimum of 15 experiments.) 
 
1.​ Write python program to print Hello World  

2.​ Write a python program to get string, int, float input from user  

3.​ Write a python program to add 2 numbers 

4.​ Write a python program to perform arithmetic, assignment, logical and comparison operators?  

5.​ Write a Python program to add two positive integers without using the '+' operator. (use bitwise operator)  

6.​ Write a Python program to perform the basic four operators (+, -, *, /) 

7.​ Compute the GCD of two numbers.  

8.​ Find the square root of a number. (Newton’s method)  

9.​ Exponentiation. (power of a number)  

10.​ Find the maximum of a list of numbers. 

11.​ Create a list and perform the following methods 1) insert() 2) remove() 3) append() 4) len() 5) pop() 6) clear()  

12.​ Write a python program to find the length of list?  

13.​ Write a python program to find the smallest and largest number in the list? 

14.​ Write a python program to print a number is positive/negative using if-else.  

15.​ Write a python program to find largest number among three numbers.  

16.​ Write a python Program to read a number and display corresponding day using if_elif_else?  

17.​ Write a python program to print list of numbers using range and for loop 

18.​ Write a python code to print the sum of natural numbers using while loop? Write a python program to print the 

factorial of given number?  



 

 

19.​ Write a python program to find the sum of all numbers stored in a list using for loop?   

20.​ Linear search and Binary search.  

21.​ Selection sort, Insertion sort.  

22.​ How to create, slice, change, delete and index elements using Tuple.  

23.​ Find First n prime numbers.  

24.​ How to create, slice, change, add, delete and index elements using list.  

25.​ Programs that take command line arguments (word count)  

26.​ Write a program to reverse the string.  

27.​ How to change, delete, add and remove elements in Dictionary.  

28.​ Find the most frequent words in a text read from a file.  

29.​ Simulate elliptical orbits in Pygame.  

30.​ Simulate bouncing ball using Pygame. 

Course Outcome:  
1.​ Proficient in understanding Python syntax and semantics, as well as creating arrays and functions. 
2.​ Capable of learning and working with various data types in Python, including lists and dictionaries. 
3.​ Skilled in executing programs using loops and control statements. 
4.​ Proficient in learning decision-making concepts and implementing functions in Python. 
5.​ Skilled in handling files and managing exceptions in Python 

 

 


	UNITII:SEMICONDUCTOR DIODE​​[09Hrs] 
	UNITIII:WAVE OPTICS​​[09Hrs] 
	​ 
	UNIT IV: LASERS AND FIBRE OPTICS​​[09 Hrs] 
	Einstein’s theory of matter-radiation interaction and A and B coefficients, Amplification of light by population inversion in optical resonator, Different types of lasers: Solid-state laser (Nd:YAG laser), Gas laser (CO2 laser), Semiconductor Laser. Properties of laser beam & its applications. 
	Fibre Optics: Introduction, Total internal reflection, Propagation of light through optical fibre, Acceptance angle and acceptance cone, Numerical aperture, Types of optical fibre on the basis of Modes of propagation & Index profile, V-number, Fibre Losses (attenuation) and Dispersion, Advantages & Applications. ​ 
	​ 
	UNITV: DILECTRICS AND ELECTRON BALLISTICS​​[09 Hrs] 
	Dielectrics: Dielectric constant, Dielectric Polarization, Bound and free charges, Relation withpolarization, Gauss's law in dielectrics, Dielectric susceptibility, Displacement vector D, E, andP vectors, Polar and nonpolar dielectrics, Different types of polarization, Temperature andfrequency dependence of total polarization. 
	Electron ballistics: Motion of charged particles in transverse electric and magnetic field, Aston and Bainbridge mass spectrograph.​ 
	 
	TextBooks: 
	 
	 
	ReferenceBooks: 
	 
	 
	 
	E-resources/Web Sources: 
	 
	 
	 
	 
	UNITII:FRICTION  ​     [09Hrs] 
	(a)​Introduction, Types of friction, limiting friction, Laws of friction, Static and dynamic friction, Angle of friction, Angle of repose, Cone of friction, Friction on body, Wedge friction, Belt and rope friction, Ladder friction, Belt drives, Ratio of tensions, Simple screw jack. 
	(b)​Principle of virtual work.​ 
	UNITIII: MOMENT OF INERTIA                                                   ​​[09Hrs] 
	Introduction, Centre of gravity, Centre of mass, Moment of Inertia, Plate,Cylinder, Cone, Sphere.Centroid of one dimensional and twodimensional body, Centroid of composite sections.              Moment of inertia of rectangular plane, Polar moment of inertia, radius of gyration of area, Theorems of moment of inertia, Product of inertia of plane section, Displacement of axes, Rotation of axes, Principal axes, Principle of moment of Inertia.  
	 
	UNIT IV: KINETICS AND KINEMATICS​     [09Hrs] 
	Rectilinear motion of Particle; Displacement, Velocity, Acceleration, D’Alembert’s principle, Work and energy principle, Principle of conservation of energy, Power, Impulse and Momentum principle. 
	​ 
	UNITV: FLUID PROPERTIES​​[09 Hrs] 
	Introduction, Mass density, Weight density, Specific volume, Specific gravity, Viscosity, Ideal, Real, Newtonian and Non-Newtonian fluids, Compressibility and bulk modulus, Surface tension, capillarity, Vapour pressure, Pressure in fluid, Pascal’s law, Hydrostatic law, Manometry, Hydrostatic force on submerged plane and curved surface, Buoyancy and floatation 
	 
	TextBooks: 
	 
	ReferenceBooks: 
	E-resources/Web Sources: 
	 
	5. Basic Electrical Engineering in Hindi, Mr. M. L. Anwani, Dhanpat Rai & Co. (P) Ltd 
	 
	E-resources/Web Sources: 
	TextBooks: (Hindi and English language as per availability) 
	ReferenceBooks: (Hindi and English language both) 
	 
	 
	E-resources/Web Sources: 
	 
	 
	 
	 
	 
	 
	TextBooks: 
	 
	S. Chand Publications, New Delhi. 
	 
	ReferenceBooks: (Hindi and English language both) 
	 
	E-resources/Web Sources: 
	●​https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9ASK 
	 
	1.​To determine the Numerical Aperture (NA) of an optical fiber. 
	2.​To determine the wavelength of a given LASER source using a diffraction grating. 
	3.​To study characteristics of a solar cell. 
	4.​To study the characteristics of a Photo resistor. 
	5.​To determine the value of plank’s constant (h) using a photocell. 
	6.​To determine the forbidden energy gap of a P-N junction diode. 
	7.​To study the characteristic curve of a P-N junction diode. 
	8.​To determine the specific resistance of a given wire using a carry foster bridge. 
	9.​To determine fringe width of an interference pattern using Fresnel’s bi-prism. 
	10.​To determine the frequency of A.C. mains by a Sonometer. 
	11.​To determine the resolving power of plane transmission grating. 
	12.​To determine the radius of curvature of plano convex lens by Newton’s rings method. 
	 
	Text Books: 
	 
	S. Chand Publications, New Delhi 
	E-resources/Web Sources: 
	●​https://www.youtube.com/watch?v=LiyxHJw_oG0&list=PLuj0MqGVQvgp31abJfYJwNzCY4bPZ9ASK 
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	1- प्रोग्रामिंग एंड प्रॉब्लम सॉल्विंग थ्रू पाइथन लैंग्वेज (Programming and Problem Solving Through Python Language)(Hindi & English Combined) Prof. Satish Jain (प्रो. सतीश जैन), Shashi Singh (शशि सिंह) 
	 

	 

